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ABSTRACT
I have always regarded font creation as an area of design that is highly specialized, requiring
great attention to detail, and using highly skilled, hand drawn techniques to achieve the ultimate end
result. While these prospects may still hold true in many respects, technological advancements have
brought about great change to the overall process of design.
As technology has evolved, so too have the methods of production for font and typeface design.
New applications offer a multitude of interesting ways to create and design fonts. Over time, these
methods of production have become increasingly more obtainable for the public and in some cases,
simplified for the basic, non-designer. As a result, an increasing amount of users, both trained and
untrained now have access to font design programs and applications.
This project will examine the practice of font design, in both a historical context and through
current trends, and will then apply this knowledge to a current software solution, in order to describe
the current techniques of the creation process. In addition to this, each step of the process will be
documented in order to provide a greater understanding of what is involved when learning the current
process of font design. As a result of this study, the ultimate objective of this project will be the final
creation of a fully realized and functional font.
A downloadable version of the font design for this project can be accessed through the link below:
https://drive.google.com/file/d/1ZODa_kNn2yyYpP6PbtwnG4mYp6MgMTuq/view?usp=sharing
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INTRODUCTION
Throughout my life, I have always been fascinated by lettering and how simple alterations to
the visual composition of an individual character or line of text can create different connotations and
bring about new levels of meaning to the message or identity that is being conveyed. As a child, I
created sketches and drawings that emulated the logos of my favorite bands and popular musical
groups of the times. As I grew older, I continued to play around with letter design, and began to create
entirely new logos and designs for identities that in my mind, were thought to be lacking. All along, I
was continually interested in how font choices could radically change a products identity and bring a
whole new feel to the design, just by changing the way that the letters looked.
What type of project will you do?
My project will entail the development of a new font that I would like to create from scratch.
Because of this, it will be considered an artifact based project. In addition to this, I would like to cover
some of the history of font design, current trends in design practices, and then document my overall
process and experience of learning how to create an actual font.
Topic
The actual process of font design has always eluded me. It has seemed to be a cumbersome
process that involves much tweaking and perfecting to get a final end product that is eloquent and
useful in different applications. Because of this, I would like to study the design process of a font, its
history and current practices in the digital world.
Tentative title
“Creating the Letterform in a Digital World: The design and delivery of a font”
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Research objectives (what are your goals in this work?)
I have always wanted to learn more about how fonts are made, and what goes into their
production. As a graphic designer, I sometimes feel that being able to create a font on my own would
allow for me to have more creative control in a project, and not have to be limited or rely on the
letterforms designed by another artist. In addition to this, I also would love to be able to someday create
a font and make it available for eventual purchase in the marketplace. Font design has always been a
mysterious topic that I have not had training in, or fully understood. By studying font design in this
capstone course, and having firsthand experience in its creation, I feel that I can provide myself with an
opportunity to learn something new, that can provide a new area for self expression in my career and
beyond.
Research questions (what do you hope to find out?)
1. How have fonts traditionally been created?
2. How are font designers typically trained?
3. What are the current practices/methods used in the digital realm?
4. What makes a good font?
5. What are the differences between fonts such as handwritten, display, novelty and other fonts?
6. What are the differences between the current applications that are used to create fonts?
7. Are faster digital methods better than earlier more primitive methods, and how are they
different?
8. What type of skills are needed in order to be successful in this endeavor?
Areas of literature you plan to review
I would like to trace the history of font design, and then proceed to more current practices.
Some of this information could be found in scholarly articles, journals, books, and information across
the web. Many established artists and creators use blogs, websites, podcasts and video presentations to
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present their work, and I feel that these sources could be called upon as well, provided that they are
reliable, experienced sources that can contribute meaningfully to the conversation.
Tentative methods (how do you think you will you go about doing this project?)
I have begun to design characters for the font in Adobe Illustrator and have researched various
contemporary programs and applications that are used specifically for font creation. Once I have
decided upon the particular program that I would like to use, I will begin converting my letterforms
into an actual font that can be used within a mac or windows based system. I will document this
experience along the way. In addition to this, I will continue my research of both the history of font
design and contemporary practices for the written aspect of my capstone project.
Anticipated results and obstacles
I would like to have a complete working font at the end of this project, but I realize that this can
be a very time consuming process that is not typically completed in a short amount of time. Because of
this, I would like to complete a minimal set of letters and/or numbers that I can continue to work with
in the future. My overall idea is to learn what the current process of font creation is, and document my
basic experience in creating a font of my own. I feel that this will provide me with a greater
understanding of this area of design, and firsthand experience that will allow me to continue to refine
and use in my career and personal projects.
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LITERATURE REVIEW
A Brief History of Typographic Design.
Handcrafted lettering and letterforms have always been an important aspect of writing and
communication. The intricacies of handwriting and hand lettering are both beautiful and expressive and
allow for designer to “bring living energy to the page” and offer a sense of caring affection or grace
(Bringhurst, 2015). The invention of the printing press by Johannes Gutenberg in the 15th century
offered a new method for the mass production of printed materials such as books, pamphlets and
newspapers, but before this occurred, printed materials were often done by hand and reserved mainly
for the wealthy, upper echelon members of society (Chapman, 2020). Handwritten books and
manuscripts were detailed works of art, that required highly refined calligraphic skills and matching
sense of patience to design properly. The printing press allowed for a less expensive and more efficient
way to produce printed materials, and in-turn brought a much greater amount of printed materials to
the masses, but these early letterforms were massed produced and often lacked an expressiveness that
hand written type offered.
Figure 1.
Black Letter Font

Note: From “Typography & Typesetting” by R. Labuz, 1988, p.33, Copyright 1988 by Van Nostrand
Reinhold Company
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The earliest example of font design can be traced as far back as the handcrafted lettering of the
black letter calligraphy (Figure 1). Guttenberg had based his letterforms on these handwritten designs
and created what is now known as movable type (Labuz, 1988). Movable type was exactly that, a way
to rearrange blocks of type for printing on a page that could be re-used and reproduced quickly and
efficiently. The blocks that contained these letterforms were made from a mold and could be reused for
later use (Lupton, 2010). The blocks were then set by hand, and the process could be very time
consuming, but it offered the opportunity for mass production (Labuz, 1988).
The earliest typeface designs for movable type were based on the calligraphic handwritten
scripts that came before them. These were often bold, densely populating the page, and inconsistent in
width, in a desire to mimic a handwritten style, but often took up too much space to fit neatly on a page
(Lupton, 2010). Due to these reasons, Roman “humanist” typefaces became introduced as a way to
introduce wider, open forms of type and save space on the page which would allow for smaller books
to be printed at a lower cost (Chapman, 2020). Movable type became the most prominent way to print
type, and this technique remained the “main method of composition until the 1880's” (Labuz, 1988).
Figure 2.
Jenson Font

Note: From “Typography & Typesetting” by R. Labuz, 1988, p.37, Copyright 1988 by Van Nostrand
Reinhold Company
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Historical advances in type design have allowed for greater readability, this became evident
with the introduction of serif fonts such as Garamond, Jenson (Figure 2) and Bembo. These fonts
featured sharp, flowing lines that were rounded and lighter than what had come before them (Lupton,
2010). The shapes were thought to mimic the human form and exhibited a graceful artistic flow to their
composition. Each of these fonts have stood the test of time and are still commonly being used today.
Figure 3.
Caslon Font

Note: From “Typography & Typesetting” by R. Labuz, 1988, p.43, Copyright 1988 by Van Nostrand
Reinhold Company
The introduction of the first san-serif font known as Caslon in 1816 ushered in a modern style
of typography influenced by industrialism and mass production (Labuz, 1988). This design consisted of
block letterforms did not have serifs, were more uniform and lacked the differences in thin and thick
properties that the more elegant san-serif fonts had. Advertising had also had an impact during this
period and type designs were becoming bolder and more brash (Labuz, 1988). Caslon may have not
been universally accepted, but its influence on later designs was undeniable (Labuz, 1988). Ornamental
and three dimensional designs were the novelty font designs of the time and often used in advertising
for headlines on posters and other display purposes. These font designs were often looked down upon
as “gross and immoral” (Lupton, 2010). These designs would soon be looked upon as antiquated, as the
world of typographic design evolved.
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Figure 4.
DeStijl Font

Note: From “Thinking With Type” by E. Lipton, 2010, p.26, Copyright 2010 by Princeton
Architectural Press.
European, avant garde movements such as Bauhaus, Constructivism, Futurism and De Stijl
rejected the historically based designs of the past by introducing radical new designs that incorporated
block like, geometrical shapes with a greater focus on abstract designs that challenged contemporary
thought and design aesthetics (Lupton, 2010). These were modern, visually shocking designs that
eschewed the human form oriented designs of the past to produce an almost industrialized and
futuristic look to some of their designs. The theories of Bauhaus stressed function and meaning, and
rejected the “flourishes and florets” found in other work of the past (Labuz,1988). An example of De
Stijl can be seen in Figure 4.
Contemporary font designers of the 21st century have continued to evolve the art form by
incorporating distinct influences into their work. These new directions have brought about politically
and socially charged forms of expression that are informed by the past, yet offer new perspectives that
are unique to the current generation. The designs are emotionally impactful and relevant to today’s
world.
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Figure 5.
William Font

Note: From “William” made by Tré Seals from www.vocaltype.co/wip
Tré Seals is a graphic designer who uses design to tell stories and create change in the
turbulence of the current social and political landscapes. His font designs are inspired by the social
movements of the past, such as the civil rights movement, and the women's suffrage movement, and he
incorporates these influences into the visual look of his new designs. In particular, the sign art and
printed materials of these social movements provide inspiration for the visual look of his design work.
The fine detail and nuances of the handmade political poster art of those times are captured in his
letterforms and font designs. Munro states that “Letterforms are loaded cultural objects—they often
reflect the people who made them and the story they want to tell” (Munro, 2019). As a form of
expression, Seals desires to bring a voice to the design field from “creatives of color who feel they
don’t have a say in their industry” (Munro, 2019). His creative work allows for a story to be told, a
unique point of view to be heard, and introduces a sense of diversity into the field of design. In his font
design for “William”, Seals takes inspiration from the work of W. E. B.Du Bois and the fonts featured
in his data visualizations that use “only straight lines”, and are “more akin to the no-nonsense
letterforms seen in architecture and engineering plans” (Munro, 2019).
Modern Progress In Typographic Design
As times have progressed, the methods of typographic design have dramatically changed.
During the twentieth century rapid advancements in technology have changed the process of font
design and introduced new techniques and software programs that have made the process of designing
a typeface more streamlined and less time consuming, and as simplified as the designer desires it to be.

10

Creating Letterforms in a Digital World: The Design and Delivery of a Font

In the 1980’s, computer software was becoming less expensive and more consumer friendly.
Desktop programs such as Adobe Photoshop and Illustrator changed the tactile world of graphic
design, bringing the many of the hand drawn techniques of the past into the computer age. Software
programs such as Fontographer allowed designers with the possibility to design a font in just “a few
minutes” (Dobrin, 1988). These advances allowed for a streamlining of the lengthy design process, but
also posed potential problems as the initial code that was created in Fontographer would often need to
be further adjusted for refinements in a program such as Adobe Illustrator (Dobrin, 1988). As a method
for creation, this was an important development, but it lacked several factors that would make it more
accessible and usable to the masses. The software programs and desktop systems of this time were still
expensive to the everyday user, and required a significant investment to fund for acquisition.
As technology has been consistently refined and improved over time, so to has the tools that are
available to the graphic designer. Today's software programs such as the design tools of the Adobe
Creative Suite: Indesign, Photoshop and Illustrator have brought professional level tools that are
affordable and accessible into the everyday user. This leveling of the playing ground has democratized
design, taking it away from the hands of the educated fine artist and allowing almost anyone with a
computer to have the opportunity to learn the techniques of the designer. The internet has compounded
this process by allowing opportunities for start up companies and small businesses to introduce creative
new applications and programs directly to consumer audiences.
New applications such as Calligraphr, Fontself, Fontforge, Fontstruct and iFontmaker allow for
different levels of features and options to users who are interested in creating their own designs. Many
of these programs are marketed towards both beginners and seasoned professionals, and offer a variety
of options that provide creative control and a streamlined functionality. These programs offer anywhere
from a simplified approach that allows the user to scan in their own handwriting, to a more traditional
approach where each letter is built in a vector based program where curves and points are designed
with the use of a mouse or digital pencil tool to build the structural content of the individual letter
design.
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What Does Font Design Actually Mean?
When many of us think of font design, we typically think of the end product, how visually
stimulating and vibrant it is, and how that design will bring life to the page or overall design aesthetic.
But the role of a font designer goes beyond just the visual design of the letters that is apparent in the
end product. The process is quite involved and can take much more time to complete than is often
understood by the non-designer.
Even though the world is digital, many designers start their process by hand. Samara states
“Drawing fuses neural pathways between input (seeing) and output (making)— through practice,
analysis and intuition become one, effectively allowing the maker to physically feel what is seen and to
see what is felt, on the fly, as it is happening in real time. In the jump from refined drawn or painted
forms to clicking around a screen adjusting Bézier points in software, this well-developed synesthetic
facility eventually allows a designer to better understand the moves he or she is making on screen,
despite the disconnection between mouse and creation space” (Samara, 2018). The pencil, the marker,
the ink pen or paintbrush are all possible tools for font creation, and their use encourages a creative
bond that can connect the human oriented side of design with the computer side. One current font
designer, David Kerkoff also goes as far as using objects such as a “broken satay skewer” to create his
creative designs (Kerkoff, n.d.). These methods often allow for a more natural, humanistic approach
that often looks like handwriting or hand drawn lettering. During this process, the refined
characteristics can be drawn over and over again until each detail is finely tuned and desired result is
achieved. This stage can be as long or short as the designer wishes it to be, but a professional font
designer can often take months or even years to perfect each element of the overall design.
Modern programs now allow designers to scan their hand written work into their computer in
order to digitize their drawings into rasterized art which will then become converted to vector art and
further manipulated for finer detail. These programs allow for batch conversions from raster to vector
and then individually separate each letter. Once the letters are imported as vector images, they can then
be edited, copied and further manipulated for alternate characters, ligature creation, individual kerning
and a variety of letter spacing options that are unique to each letter, and the possible letter combinations
12
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that can occur in their everyday usage. According to Clair, modern type design, through the use of
computers has “made typographic ideas immediately accessible and viewable” (Clair, 1999).
Additionally, Clair feels that the use of computers has the potential to change how designers create
fonts, and is interested in seeing how many designers “draw letters by hand, and then scan them in, and
how many work directly on the screen” (Clair, 1999).
In addition to these aforementioned techniques, fonts can also be completely built in a vector
program such as Adobe Illustrator and then later manipulated in dedicated font design programs such
as Fontforge or Fontelf. As Vilorio states, “Most font designers draw directly on a computer using a
pen tablet and a font design program” (Vilorio, 2013). This process relies less on the handmade
process, and more on the traditional vector art techniques using bezier curves and points to create a
letterform structure. In my opinion, these techniques rely less on traditional drawing skills and more
editing skills defined by the chosen software program, and require a higher level of skill from a
designer who is well versed in vector art editing.
Both of these techniques, while simplified greatly here, demand the skill of an
experienced designer in order to complete in a timely fashion. The possibilities for refinements are
almost endless, and character sets can range from minimal when creating a limited character novelty
font to vast when creating a complete set of characters containing letters, numbers, capital and
lowercase letters, ligatures and punctuation. Vilorio states, “The font design process can take one
month to several years, depending on a font's complexity. The more variations-such as bold or italicsand languages the font must support, the more complex it is, and the more glyphs a designer must
create. A simple font might need 256 glyphs, but a complex one, such as Arial, might need more than
6,000 glyphs” (Vilorio, 2013). When thinking about all of these possibilities for character set design
and then their individual settings for letter spacing, font design can become quite a very overwhelming
proposition for the beginner!
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Project Questions
1. What are the techniques commonly used in modern font design?
2. How have new technologies changed the process of font design?
3. Do earlier, more primitive methods still remain relevant with software based forms of
design in today’s digitized world?
4. How can existing methods be used in this hand-drawn font creation project?
Definition of Terms
In the study of typography, there are many unique terms that are commonly used to describe
type, and the individual parts and pieces of which each letter is made up from. For a better
understanding, this section should be regarded as a reference point for the specialized terms that are
used throughout this design project.
Timothy Samara defines the word font as “the design of a single character set, all sharing the
same proportional and stylistic qualities” (Samara, 2018). He also describes a font family as “the varied
character sets that share the same proportions and stylistic details”. This can be see in the many
variations of a particular font such as its bold, italic or condensed versions. Lupton differs in this
definition, stating that a typeface is the “design of the letterforms” and a font is more of a “delivery
mechanism” such as the “cast of metal printing types” (Lupton, 2010). The character set is a term used
to describe the “selection of characters that are included in a typeface's design” (Samara, 2018).
Similarly, Cheng defines the weight of a font as “the colour of the typeface” such as book, light,
medium or bold (Cheng, 2005). Lupton states that typeface classification “is a classification system”
that identifies fonts into different categories according to their individual style and characteristics
(Lupton, 2010). Humanist designs appear more handrawn, such as script or handwriting, serif, or
calligraphic fonts. Transitional and modern fonts are “more abstract and less organic” (Lupton, 2010).
We can see examples of this in the san-serif fonts of the modern age, such as Arial and Helvetica.
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“Typography is handmaiden to commerce”, many novelty and decorative designs are dictated
by the marketplace, and are created in “quirky” or eccentric ways in order to “attract attention” (Heller
& Pomeroy, 1997). Evidence of this can be seen in the uniquely brash novelty fonts and decorative,
display fonts that are widely used today.
The basic shape of a letter character is composed of lines or “strokes” (Samara, 2018). This can
be seen in the two vertical lines that make up the shape of the letter “H”. Samara states that the counter
is the “space that are created between and around the strokes” such the negative space that are created
within the letterform (Samara, 2018).
When composing letters, all of the letters “sit on the baseline”, where text is aligned to the
“most stable axis” or edge (Lupton, 2010). Lupton further states that the x-height is “the height of the
main body of the lowercase letter”, and the cap height is the “distance from the baseline to the top of
the capital letter” (Lupton, 2010). Ascenders and Descenders are elements that “extend above the cap
height” (ascender) and below the baseline (descender) (Lupton, 2010).

Figure 6. Typographic Illustration
The individual parts and pieces of letters are numerous and can be quite specific when referring
to the unique characteristics that make up an individual character. The above illustration, Figure 5,
shows many of the varied and particular terms that are used in order to describe the components of the
structures of many letterforms. These include the terminal, the stem, the serif, bowl, counter,
15
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arm, and crotch.
The basic standardized form of height measurement for type relies on a “point system” where
one point equals 1/72 inch (Lupton, 2010). In addition to this, the set “width” of a letter is the
“horizontal measurement of the body of the letter, plus the sliver of space in between that protects it
from other letters” (Lupton, 2010).
Many characters have alternate versions that use the basic shape of a letter to form a new
character, these are referred to as “glyphs” (Unger, 2018). Unger defines a “diacritic” as “a mark
placed over, under, next to, or through a letter to change the phonetic value of that letter (Unger, 2018).
According to Bringhurst, “Ligatures” occur when “two or more letters tied into a single character”
(Bringhurst, 2015).
Clarke refers to control letters as “characters that set the style of the typeface and bring the
other characters into harmony” These letters are typically designed first and feature elements that are
often used consistently in other letter designs thereafter (Clarke, 2020).
Conclusion
“Typography in practice is the process of arranging letters, words, and text for almost any
context imaginable. It is among the most important design principles you need to master
for creating effective and meaningful graphic design.”
-Richard Poulin
The undertaking of a font or typeface design project has traditionally been thought of by most
designers as both a cumbersome and tedious process where attention to fine detail is of the utmost
importance. As a graphic designer, I sometimes felt limited by having to choose from fonts created by
others. Being able to design my own font would bring greater control and creativity to this more
passive process. The purpose of this process is to not only create a font that is both aesthetically
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appealing, and visually consistent in its design features, but to learn about the current technology that
goes into font creation, and its role within the life of a font designer. The opportunity to learn the
techniques and principles of font design is invaluable to me as a graphic designer, and something that
has eluded me for many years in my career as a graphic designer and prepress technician.
Typeface design has traditionally been an area of creation that was primarily limited to
designers with pedigrees from prestigious art schools that required the skills of a fine artist, hand
drawing each character in a meticulous process of refinement and a basis in design aesthetics. Modern
technology has made the tools for creation available to almost anyone who has a desire to learn. I feel
that this can be seen in both a positive and negative way. With the ability for anyone to now create and
design a font, there is a greater chance for less sophisticated and refined designs. The untrained artist
may lack the educational perspective and background to produce a sophisticated and traditionally
beautiful design. On the other hand, this widespread availability has opened the doors to to those
individuals who may have not had access to a design tool such as this in the past. These individuals,
while not traditionally trained, can still have the potential for great creativity, and outside the box
thinking that can push font design forward into the future, with potential new designs and new ways of
thinking.
My intention for this project is not to create a complete font with glyphs, alternate text,
ligatures, numbers and a myriad of other options. It is to work through the process and create as much
of the font as possible and examine how the overall process works. As a visual design element, I would
prefer to create a font that is more handwritten in nature and loosely based upon my own handwriting
or penmanship, but not an exact replica or duplicate. Overall, it is my desire is to learn what the
modernized process entails, the options offered, and how they differ from the standard traditional
techniques of the past. In addition to this, I would like to research how these new technologies have
changed the process of font design, and how they currently fit in with previous, more primitive
methods of font design. Are earlier methods still relevant in today's world? Throughout this process, I
hope to build as much of the font that I can, and learn the deeper intricacies of what this process is
made up from and the level of dedication that is needed, in order to create a legitimate font that natural,
flowing and functional in its design.
17
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As a research project, I feel this study will open up potential opportunities for creative growth
and greater artistic expression. The ability to create a font is also a very marketable skill, and one that
can present entrepreneurial possibilities as well. In this research, I would like to touch upon these areas
and create a presentation that will inform the audience of the history, the current practices, and a look
into the process of creation and the potential skill development that can occur when creating a font
design.

18

Creating Letterforms in a Digital World: The Design and Delivery of a Font

METHODS
Software Research
My initial research for this project began as a simple online search for font design programs that
were available through digital download, and purchasable online. The choices were varied and offered
many different programs to explore, some of which consisted of standalone software packages, and
some that could be used as extensions to popular design programs such as Adobe Illustrator and Adobe
Photoshop. I decided to compare these projects using the competitive testing method, in order to
determine the most useful option that could meet my needs for this project. Martin & Hanington states
that this type of research is used to “evaluate the usability and learnability of your competitors'
products” (Martin & Hanington, 2018). This method is typically used in marketing and business to
assess a competitor's products and services, and in this case, I felt the technique would be extremely
beneficial in determining the most feature rich and convenient software package to meet my usability
and design needs for this project.
Four programs were chosen as final, primary candidates for the completion of this project.
These programs consisted of Calligraphr, FontForge, Fontself and FontLab 7. In my comparison of
these programs, I decided to look for 4 particular qualities that could help to make this project flow
smoothly and successfully to a timely conclusion:
1. I desired the ability to create my designs in Adobe Illustrator, and then import them into a
native font design program where they could then be converted from artwork into actual
working fonts.
2. I wanted to find a program that was relatively inexpensive when compared to traditional font
building programs of the past.
3. I needed to have a program that would output the files in an Open Type Format (OTF) that
would be accepted and usable for end users of both PC and Mac based systems.
4. The programs needed to be offered commercially as digital downloads and easily accessible
online.
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My Reasons for having these particular demands when finding a Font program were numerous.
As time constraints loomed over a one semester course such as this, I desired to use a program that I
was familiar with, in order to build the basic letterforms and characters. This would enable me to speed
up the process of design, and greatly enhance my already established skills in Adobe Illustrator.
Additionally, it would prevent the necessity to having to learn a completely new design program that is
not as universally accepted such as Adobe Illustrator. The program must also have the ability to output
font files in a format that is universally accepted on multiple types of platforms by many different types
of users. Finally, I wanted to use a program that was widely accessible and more affordable to the
public than the typical font design programs that can cost hundreds or more dollars. In my opinion, this
would level the playing field for everyday graphic designers, allowing them to have the ability to have
access to greater creative possibilities and control at an inexpensive or much more affordable price
points.
Four applications were ultimately chosen based upon these specific qualifications:
Calligraphr (www.calligraphr.com) - Free Cost. Hand drawn/Scan based creation. Full open type
font format.
FontForge (www.fontforge.org) - User donation as Cost. All design is done in FontForge Program.
Full open type font format.
Fontself (www.fontself.com) - $39.00 Cost. Design can be done in Adobe Illustrator or Photoshop.
Full open type font format.
FontLab7 (www.fontlab.com) - $459.00 Cost. All design done in the FontLab program. Full open
type font format.
Each of these sophisticated programs had both pros and cons to their offerings. They all
provided a standardized output in the OTF format, which would allow for greater usage among all
types of potential font users. They were also all readily available through digital download online, but
these were the only similar qualities that they had all shared, and there were obvious differences in
many other ways. Three of the four programs were relatively inexpensive or free to download online.
FontLab 7 was the most expensive at $459.00, while Fontself was much more affordable at $39.00.
20

Creating Letterforms in a Digital World: The Design and Delivery of a Font

Calligraphr and FontForge were both free or offered an option to donate funds, and as a result, both
seemed much more affordable.
In terms of design programs, only one program, Fonself, was supported through Adobe
Illustrator, while another, Calligraphr used uniquely hand drawn and scannable input through an image
editing program such as Adobe Photoshop. The other programs were native to their own software and
offered a complete all in one package, where the design and conversion could be done with out the
need of other software or hand drawn techniques. Having an all in one package initially seemed
appealing, but the time required to learn a new design program seemed counterintuitive to the design
process, and could result in a slower design process.
After careful consideration, I decided to use Fontself. It offered itself as an extension to Adobe
Illustrator, where all design could be done in Illustrator, and then dropped into Fontself for final editing
and conversion. Its price point was relatively affordable, and it seemed to be the easiest package to
learn and use. I wanted to continue to develop my skills in Adobe Illustrator, and this would allow me
to create the designs in a program that I felt initially comfortable with. My final decision to use
Fontself met all of my rigid requirements, and presented itself in a convenient and easy to learn way to
learn type design.
Visual Style and Font Classification Research
Another research method incorporated into this project was artifact analysis. This type of
analysis involves the “systematic examination of the material, aesthetic and interactive qualities of
objects” (Martin & Hanington, 2018). By examining sites such as dafont.com, myfonts.com and
hanodedfonts.com, I assessed the features and qualities of commercially accepted fonts designed by
established artists and creators, and decided upon a style that was both relevant, and functional for the
project at hand.
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It was my desire to do something that could be creative, and more natural looking. I wanted to
have an element of texture in the design, and less of a “manufactured” look. Many of the designs that
are offered on popular sites such as www.dafont.com are unique, unconventional, and radically
creative. They allow for a more informal look that is often worn, decayed and edgy and mimic the style
of handwriting or a natural weathered look. In three examples of different font styles, we can see
handwritten, distorted and decayed looks (Figures 6, 7 and 8).
Figure 7.
Simplicity Font Made by V. Bays

Note: A natural, handwritten design.

Figure 8.
Bad Grunge Font Made by J. Garrow

Note: A weathered and distorted design.
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Figure 9.
Sketch Zone Font Made by M. Art

Note: A textured design.
Each of these design examples (Figures 6, 7 & 8) employ a very textured, imperfect look that is
less formal than conventional font designs such as Helvetica or Arial. They incorporate, rough edges,
textures and unique qualities that are not symmetrical, or reminiscent of mass produced materials.
Lidwell refers to mimicry in design as “the act of copying properties of familiar objects in order to
improve usability, likability or functionality of an object” (Lidwell, 2003). He further states that surface
mimicry is defines as “making an object look like something else” (Lidwell, 2003). It was my
intention to mimic handwriting in order to provide a natural aesthetic, that is both familiar and inviting
to the user and offering a personality and vibrancy that is all its own.
Ultimately, I have decided upon a handwritten font style, that could possibly provide for a
unique design experience, and visually creative end product. My reasons for deciding to create a
handwritten, humanistic font were twofold. I wanted to mimic a few of the qualities of my own
handwriting in some ways. I felt this would bring a more unique aspect to the design. I also thought
that a handwritten design could allow for a more expedient experience, since the time restraints of
completing a design project of this magnitude could be prohibitive with the more consistent and precise
font design styles of a san serif font, that would involve more geometrically oriented designs.
The third research method encountered was a form of evaluative research to determine the
functionality and usefulness of my font design. Even though the design was not completely finished, I
personally went through a series of tests to determine the letter spacing and placement when using the
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font in words and sentences. During this process, I encountered several errors and inconsistencies
occurring which needed to be addressed. These mainly involved the sizing and placement of characters,
the positioning of glyphs, and the spacing of characters. As I tested possible letter combinations, I
became aware of the need to be sensitive to the letter spacing settings as I manufactured each character
and glyph. Some letters would appear to be kerned too close together, and others would look oddly far
apart. Overall, it was inconsistent and needed to examined further at the end of the design stage
process.
Character Set Design Process

Figure 10. Stick Figure Beginnings
Cabarga states that letters that start out as “stick figures” can be easier to illustrate because one
line can define a letter's inner and outer shapes, the outlines can have an additional stroke added to
increase width (Cabarga 2004). With this statement as an inspiration, my design process began rather
simply, with the basic pen tool in Adobe Illustrator (Figure 9). I created a guidelines for the baseline,
descender line, ascender line and x-height lines in order to have a consistent area for character
placement and sizing. Uppercase letters were started at first, with the option left open for numerals and
lowercase letters. I began with typical control letters that define the majority of the features and basic
proportions”, such as H, O, I and n, that could be built first and them used later as the foundation for
other letters (Staff, 2012). This technique would keep my letterforms consistent, and establish a
uniform look and basis for my design ideas. As I built my first letter, I established a foundation for
width, cap height and x-height, and maintained a consistent proportion between each these parameters.
As I progressed through the project, I would become more aware of what my ability would be, in order
to create as many characters as possible, in the condensed timeframe that a typical semester based
course allowed. As I learned the techniques necessary to build each character, it became apparent that I
would be able complete a set of uppercase, lowercase, numeric and basic punctuation for my
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character set.
Each letter was then drawn in proportion to the next, keeping it consistent, but not perfectly
aligned, in order to provide a more natural look and feel to the sizing and positioning of a handwritten
font.

Figure 11. Art Manipulation and Designs
I then proceeded to draw the basic letterforms of all the letters this way. I wanted to create a
very tall, sleek looking aesthetic to the capital letters and numbers (Figure 10). I also added sharp edges
to create what I hoped to be perceived as a more sophisticated or refined look. Because my design was
more angular and sharp, I relied less on the bezier curve tool technique, and more on building shapes
from points established with the pen tool and circular shapes created from the eclipse tool. Specific
parts of letters, were created using this technique, such as the bowl of the letter “P” or “B” were
constructed by using the eclipse tool and converted to shapes by uniting the stem with the bowl to
create one new piece or character. I often, cut and pasted pieces that were common to many different
letterforms. This helped to maintain a consistent look.
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Figure 12. Pathfinder Tool Usage
As I drew the points of each letter with the pen tool, I added a stroke of .156 and set the color to
100% black. If letters were made up from more than one piece, such as multiple lines and shapes, I then
used the pathfinder tool to divide the shapes up, edit the excess pieces, and then create one piece of art
that could later be converted into a shape using the Object>Convert to Shape feature (Figure 11). An
alternate process was also used for some difficult shapes using the Object>Expand Appearance
feature. This would allow for me to build and adjust the look of all the letters in a way that would keep
the look more or less consistent across the board, and eliminate excess pieces that might become
problematic when re-sizing or scaling the artwork in Fontself later on. My goal was to create the
letterforms to look as if they came from the same pen or pencil, with similar weights and widths. A
look that wasn’t meant to be perfectly uniform, such as a serif or san-serif font, but consistent enough
to look like the stylized handwriting of an actual human being.

Figure 13. Shared Font Characteristics
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Each letter would be individually created, and a follow defined style that was established to
create consistency. This can be seen in the horizontal stroke or “bar” of the uppercase letters of Figure
11. I maintained a similar positioning that can be seen in letters such as A, E, F and B. This style was
also maintained by using the cut and paste technique for individual pieces that was mentioned earlier.
By utilizing these two techniques, my results became more stylized font and uniquely consistent.

Figure 14. Primitive Look and Hand Drawn Effect
Once the entire alphabet was completed in uppercase, I adjusted the stroke to be consistent for
all of the letters. As a final touch, I decided to use effects that are offered in Adobe Illustrator to
manipulate the look of the letters. I selected Effect>Stylize>Scribble to achieve a natural scribbled
effect to the letter, and Effect>Distort & Transform>Tweak to add an element of roughness to the
look. At this point, I opened up the “Brush Libraries” and used the “Artistic_Paintbrush” options to
select different options to provide a more hand drawn look to the primitive letters. This was a process
of refinement, where I tried many different brush types and stroke weights to perfect the look and
visual composition that I was trying to achieve. After many attempts, and countless combinations of
brushes and stroke weights, I finally decided upon a look that was slightly rough edged and natural
looking, but also unique from other fonts that I had viewed earlier in my research for the visual design
of the project This can be seen in Figure 13. The roughened appearance can be particularly noticeable
on the terminals of the stem, and leg of uppercase letters such as R, T and N. It was at this point, where
I selected the alphabet as a whole and then converted the letters to shapes. Because the Fontself
extension allows for design editing, the letterforms needed to be one complete shape, and not made up
of small individual pieces.
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Figure 15. Lower Case Consistency Formatting
This entire process was then repeated for the numbers, punctuation and lowercase letters.
Because lowercase letters have descenders, extra care was taken to align each descender and create a
basic form of consistency for all of the letters to follow. This can be seen in Figure 14. As I completed
the lowercase letters, I realized that I had used a slightly different distance in measurement for the
baseline and x-height lines of the upper and lower case letters, resulting in a lowercase letter that is
slightly shorter in x-height than I had initially intended. I chalk this result up to first time experience,
and not having compared the lower and uppercase letters sooner in the process. The result may be less
apparent to some users, but remains an important issue as I learn the process. In the interest of time, I
have decided to move forward with the current design in order to complete the project, but I will reexamine the comparative heights and proportions of the upper and lowercase letters in the future, and
refine it further, as I move ahead.

Figure 16. Fontself Application Window
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At this point, all of the basic characters were now complete, and the design process would move
from Adobe Illustrator to the newly acquired extension “Fontself Maker”. In Fontself, all of the created
artwork can be imported into the application in two ways. Individually by character, or grouped by an
entire batch, such as all lowercase, uppercase or numerical characters (Figure 15). I proceeded to “drag
and drop” my letter designs into the Fontself window, but did not have luck. My initial attempts at
importing the files had failed, and I needed to figure out why the errors were happening. After
researching the Fontself site, I came to the realization that my designs had been made up of so many
individual pieces and then processed with filters, that the amount of points contained within the vector
artwork were unquestionably large and beyond the capabilities of the Fontself software. As a result,
Fontself could not interpret the large amount of information that I was feeding into it, and would not
accept my meticulously labored artwork as I had intended it would. This provided a serious issue for
my progression into the Fontself application, and would not allow me to move forward in my design
process.
In order to get past this barrier, I decided to clean up my design by using the
Object>Path>Simplify feature in Illustrator. This feature typically eliminates unnecessary points that
are used in order to build a vector shape in Illustrator. As a result, it can often manipulate the way an
image looks or appears on screen. In this case, my letters were becoming warped and radically different
than how I had intended them to look, and another solution was needed in order to proceed.
As an alternate solution, I decided to open my font alphabet into Adobe Photoshop and export
using a bitmapped image. This involved opening the vector art at 1200 dpi and converting it to a
rasterized image, before changing the mode of the rasterized version to a bitmap. I could then re-import
the image into Illustrator and convert the art into a more user friendly vector image, thus reducing the
amount of points used, and not losing any noticeable or perceived image quality. At this point, I used
Image trace>Make and Expand to successfully create a new character art file that would be smaller
in file size and more simplified overall. This was a small setback, but it allowed for me to move
forward with a design that could be easily converted into a font in the Fontself application.
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Importing Designs into Fontself
My designs were now ready to move forward! As an import method, the drag and drop
technique was quite convenient, and immediately allowed for successful for conversion of my entire
uppercase alphabet into the Fontself application.

Figure 17. Art to Font Matching Process
Once my letters were brought into Fontself, the designs needed to be assigned to the typical
characters that were located on a keyboard or input device. This involved matching up each letterform
to its respective counterpart on the input device (Figure 16). I quickly proceeded to complete all 26
letters in the uppercase alphabet. As the letters were linked, they could now be tested with a live
preview window in the Fontself program for correct keystroke mapping, and additionally for spacing,
kerning and baseline issues that could effect letter placement when using in typical words, sentences or
paragraphs.
After all mapping was completed, I proceeded to test spacing issues for each letter (Figure 16).
The letters were first assigned an automatic standardized spacing for each character. This initially
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worked in a primitive way, but was fairly even spaced and lacked the nuance and sophistication of a
font that is finely tuned for each individual character. I decided to try the smart spacing option that
automatically adjusts spacing and kerning for each glyph. This resulted in a much easier to read font,
but still required fine tuning for the letters to look natural and flow on the page as if they were written
by hand.

Figure 18. Art to Font Conversion and Spacing Panel
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At this point, I realized that it would be essential to begin manually testing each
character out to see if there were potential spacing issues. I knew that this would be an important and
time consuming part of the design process, and one that will continue long after this thesis project has
been completed. The preview screen provided by fontself allowed for me to do this easily, and the
palette allowed for instant viewing of all adjustments to the character spacing (Figure 18). I began to
tweak as many characters as I could see fit. At first I experimented with the periods that seemed to be
kerned too closely together and needed more spacing on both the right and left sides. The spacing was
increased from a value of 5 to a value of 20 and became much more evenly spaced in proportion to the
other characters. After this, I attempted to adjust the numbers, particularly “4” and “7”. These were
kerned significantly closer than the other numbers and resulted in a change from “5” to “47” in the
spacing palette. Overall, the font is looking good at this point, but will still need tremendous fine tuning
amongst the individual characters. This aspect of the design will end up becoming a work in progress,
and something I will refine as I get more comfortable with the application and its features.

Figure 19. Character Preview Panel
Once I became pleased with the spacing and kerning of the letters, it became time to save the
file and test the font in a program such as Microsoft Word, Adobe Indesign and Adobe illustrator.
Fontself makes it easy to save and install your font design at any point in the project. At this point, I
saved the file as an OTF font and proceeded to install it on my Apple computer.
Voila! Without any further significant issues in the conversion process, my font was now
working as an open type font, installed on a macintosh computer! Behold Figure 19, “Trying Tines” a
simple handwriting font!
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Figure 20. Font Reveal
Conclusion
I had planned for the process of design to be very long and involved. I knew going into the
design stage that tremendous care would need to be taken in establishing a detailed and consistent look
to the font design. Furthermore, I was anticipating a period of adjustment as I learned new font design
techniques in both Adobe Illustrator, and the Fontself application. My experience in using graphic
design software ended up providing a significant and timely advantage when dealing with the problem
solving issues that became apparent when converting my designs to the Fontself platform, and allowed
me to spend more time adjusting the finer visual details of spacing and kerning issues in the new
platform. This experience allowed for me to get further along in the design process than I anticipated
and build a more complete font that featured not only upper and lower case letters, but numbers and
basic punctuation. The results surprised me, and continue to provide inspiration to learn the intricacies
of font design, and eventually create more complex and interesting designs.
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PROJECT OUTCOMES
As modern technology grows, adapts and develops, it has allowed the user to do things that
might once have been thought of as impossible or difficult to achieve with a smaller amount of
resources and within a smaller amount of time. These possibilities can provide both positive and
negative aspects. In terms of production concerns, these advancements can often offer a simplified and
streamlined approach that can reduce the amount of time spent on a project, but in creative terms, they
can sometimes inhibit users with potential barriers or technical disadvantages. I feel that this statement
certainly holds true for the technology that has developed in the realm of graphic design and more
specifically typeface design. New applications have provided the graphic designer with the ability to
create with an opportunity to create in many different forms. In my project, I decided to look into the
process of creating and developing a font, through the use of modern software that has basically
revolutionized the process of font design. Throughout this project, I have found both positive and
negative aspects to the technology and its offerings.
For this project, my final deliverable, a font which I have decided to call “Trying Tines” is my
first attempt at creating a fully realized typeface (Figure 20). It’s name is based on the sharp points or
“tines” that can be seen in several uppercase letters, and the wordplay is based on the “trying” period of
time that the design was created during, a worldwide pandemic.
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Figure 21. Complete Character Set and Variations
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This design, while presented here in its final version for this project, is still very much as work
in progress. I have come to the realization that the process of font design, is lengthy, and requires a
commitment to detail and refinement in order to create a design that is both versatile in its usability,
and visually interesting in its composition.
I wanted to avoid the pitfalls of a novelty typeface or current fads in my design, but I also
realize that this is a first time attempt, and I cannot expect to produce the ultimate refined and classic
font design as much as I would like to. That being said, as a handwritten script, font design, I feel my
design shares some common characteristics of other handwritten designs, but also has a unique look
that is not too jarringly eccentric or unusual. It contains some evidence of decorative elements such as
being “highly stylized,” or “less legible at small sizes” (Haley, 2012). Its main identifiable features
consist of rough, pointy edges, some unusual shapes, and asymmetrical design qualities, but in my
opinion, it doesn't seem to attract attention for attentions sake, and its intention is to provide simplicity
and a personalized touch or feel.
My testing for this font was done in Adobe Indesign and Adobe Illustrator. I successfully
converted the artwork into an OTF font that was fully editable in the Adobe product suite. As can be
seen in Figure 21, I was able to create an outlined version and add color as well. I feel that the ability to
create an outline, while maintaining readability adds a certain amount of versatility and the ability for
additional options when designing in a variety of different sizes, formats and layout situations.
Many findings were realized throughout my project development:
In terms of character design, this experience has taught me that important considerations should
be taken into account when designing letterforms that can be usable and legible at a variety of different
sizes. Fonts that are designed using a bold style will become much harder to read at smaller sizes. This
makes them more specialized for larger purposes such as titles, headings and for printed pieces such as
posters or signs. A clean font that is not too thickly constructed will allow the user to use in a variety of
different settings.
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Inexpensive, widely distributed applications can democratize the design process by putting
power into the hands of the user, or in this case, graphic designer. It can also allow non-designers the
opportunity to explore this creative field without the cost or investment of what more traditional font
design programs can incur.
Creating fonts can allow for greater creativity and expression in the design process. As a
designer, I am somewhat limited to the fonts designs that other sources provide for me. While these
opportunities are almost endless, with font offerings widely available through online sources, I still
must rely on others to find the design that matches my ideas or goals. By learning font design, I am
able to create text based designs that are completely my own, and unique to my personal ideas and
creativity.
The ability to design a font can enhance a traditional graphic designers skill set. As a tool in the
graphic designers arsenal, font design is invaluable. It allows the ability to create specific designs that
can meet a clients desired feel and look. This is a positive benefit that can only benefit designers as
they separate themselves from the rest of their peers, offering something truly unique to their client
base.
The process of font design is detailed oriented, requires patience and skill, in order to complete
the lengthy process of refinement. This is not a quick, thoughtless process. Sensitivity to the details of
letterforms and the many different situations that they can fall into must be taken into account.
Furthermore, a sense of purpose and intention can inform the design from the initial beginnings of the
project. This can allow the designer to focus on the style of font and the best techniques to be used
during the creation process. In my case, hand-drawn lettering and the use of specific tools in Adobe
Illustrator allowed for a more natural flow and visual to the design. Brushes and filters provided
textures and natural look to the edges of the design. The bezier curve tool allowed for a more natural
flow to some of the curvatures of the lettering. Each of the techniques allowed for a more detailed and
refined look to the design.
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The innate value of initially sketching ideas out by hand brought about a more natural look to
the design. I used this technique mainly in order to get a feel for the heights of the x-height, ascenders
and descenders for each character. It allowed me to devise a plan, in order to keep the letters consistent
in height, width and proportion. It also lent itself as an opportunity to develop a more natural and
humanistic form to the characters that I was creating that evolved from a more natural handwriting
form. While my characters may not have been perfect in proportion, this experience has taught me the
usefulness of sketching and planning ahead when developing these ideas.
With modern software such as Fontself, the amount of time that can be devoted to project
creation can be as minimal or as long as desired. I found this to be have both good and bad aspects.
While timeliness does offer benefits, the process of design should not be rushed or cut short.
Throughout this project, it has become quite apparent that font design is a process that requires
dedication to the design, and further refinements of each of the many letter shapes and forms. In this
case, it involved a large character set design, a process of letter spacing refinements and testing for
proper readability. The considerations of these aspects of the design demand an allotment of time and
and attention to detail, which can and should not be rushed, in order to achieve a design that is
versatile, easy to read, and in the end pleasant to look at.
As I look back at this experience, I feel that a solid knowledge base of technological training is
only one aspect of the necessary background of training required for a project of this type. The other is
a strong foundation and interest in the fine arts, which can only benefit a designer when building these
letterforms through drawings and illustrations both hand-drawn and digitally based. The proven hand
drawn methods of the past remain relevant and in my opinion translate well to the digital age when
using modern programs such as Adobe Illustrator to create character and letterforms.
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CONCLUSION AND FUTURE OUTLOOK
The initial objective of this project was to design a working font and learn the techniques
involved in designing a typeface from the ground up. In doing this, I intended to study past and current
trends by looking into the proven practices and time tested designs throughout history. The completed
font design meets this objective by providing a complete functional design that was influenced by the
designs of the past, but produced using the latest technological advances that were available through
my research at the present time.
As I look back at this experience, I feel that a solid knowledge base of technological training is
only one aspect of the necessary background of training required for a project of this type. In addition
to this, I feel that a strong foundation and interest in graphic design and the visual arts, can only benefit
a designer when constructing these letterforms. By incorporating the use of line drawings and hand
illustrations into the digital sphere, the designer has a the potential to create a final design that has a
more natural feel and flow to the letterforms. In this respect, I feel that the proven hand drawn methods
of the past remain relevant and can translate well to the digital age when using modern programs such
as Adobe Illustrator.
Throughout the design process, I have continued to refine the font, in both appearance and letter
spacing. This will continue, as I explore the options available to me through the software, and come to
complete the design as I eventually see fit.
I feel that the font design I have created will open up a new area of information design that I
would like to explore further. My desires are to use this knowledge and experience, to be able to create
fonts if and when they are needed for any projects that I come across in the future. In my professional
experience as a graphic designer, there have been instances where font creation and design was a
possibility, but the allotted timeframe was limited so that it would not be economically feasible to learn
the design process, and then immediately create a font for the project. With the experience that has
been presented in this capstone, I feel that it now allows for me to offer a unique creative package, that
is not dependent on others when applying creativity in lettering and exploring potential design ideas
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that I would like to incorporate into a professional context. Additionally, I would like to apply these
newly acquired skills to new applications and modern technology as it becomes available, as this
introduction will allow for me to continue learning the latest software and techniques, as the technology
grows and adapts.
Norman states that “Technology is an important driver for change. Sometimes for the better and
sometimes for the worse. Sometimes to fulfill important needs and sometimes simply because
technology makes the change possible” (Norman, 2013) Technology can often streamline design
processes and remove the human qualities that make art unique. As a graphic designer, these
technological changes may not always allow for the best possible designs, but they do allow for
opportunities to create and design in ways that may not have been possible before, and they can provide
a base of knowledge that can be called upon in the future, as new opportunities present themselves.
Overall, I feel that “Trying Tines” offers a unique design, that incorporates many of the design
fundamentals that were covered throughout my studies at SUNY Polytechnic Institute. It contains the
feel of handwritten lettering, and features slight characteristics in its design that contribute to its
uniquely handwritten font style. While this first attempt may not be perfect, the execution of this
project presented an excellent opportunity to research the design process, and engage in firsthand
experience using modern software to create a font that is completely new and unique to my own design
style. All of this work was done while meeting each of the project goals and deadlines set within the
condensed amount of time of a typical semester.
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LINK TO ARTIFACT:
https://drive.google.com/file/d/1ZODa_kNn2yyYpP6PbtwnG4mYp6MgMTuq/view?usp=sharing
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